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FFiirrsstt  PPrroodduucctt  IInnssttaallllaattiioonn  

You will need Administrator Privilege to install this software on your Windows based computer. 

Software can be installed and used up to ten (10) times without obtaining a user’s license. To obtain a 

user’s license, call or email TEA Systems at Sales@TEAsystems.com after installation and provide their 

“ID A:” code number that will be presented to you by the Weir software. 

Products and manuals can be installed directly from the internet site or by the optional CD-rom that will 

be sent with your order. Purchasers in California are urged to use the download method of installation. 

From an Internet Download: 

Getting to the Product 

A user logon and password is required for these papers in the User’s section. Request a logon from 

TEA Systems at Sales@TEAsystems.com 

• You can download full Product Versions from the web site at: 

http://www.teasystems.com/UserArea/Product%20Download.htm 

• Manuals for these products are located at: 

  http://www.teasystems.com/UserArea/Manuals.htm 

• Product literature including General Information, Brochures, Tutorials, Papers & 

Presentations: 

http://www.teasystems.com/UserArea/Literature.htm 

GGGeeettttttiiinnnggg   SSStttaaarrrttteeeddd   wwwiiittthhh   TTTEEEAAA   PPPrrroooddduuuccctttsss   
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Zip (Compressed)  File Format 

TEA Systems products are downloaded in “Zip” file format. Inside of each Zip container are two 

files: 

• Setup.exe, Setup.LST and 

• ProgramName.CAB 

Where the “ProgramName” corresponds to the name of the product that you have downloaded. 

Installation 

• Click on the product name to download the “Zip” file to your local computer directory. 

• Double-click on the Zip file to open the WinZip utility 

• Either: 

o Extract the Zip-file contacts into a local directory. 

o Double click on “Setup.exe” to start the installation. 

• OR click on the “Install” button of the WinZip interface  

o Or use the WinZip “Actions/Install” menu 

What’s in this Zip File? 

“Zip” File TEA Product 

WeirAnalysisProduct.zip Product Description 

Weir PSFM Focus Reticle Calibration, Focus data conversion & 

modeling 

Weir PW Profile and film uniformity modeling, Process windows, 

Dose Uniformity 

Weir Layout Graphic exposure layout and data centering tool. 

Weir FEM 

 

Focus Exposure Matrix (FEM) graphic manual data entry 

tool for collapsed lines and other Bayesian type data. 

 

Weir DM Daily Monitor, Automated, one-click data analysis, 

modeling and trend charts 

Weir DMA Provides automation for Weir PW/PSFM interfaces to APC 

and Factory Control 
 

WeirTR Installation.zip Product Description 

Weir TR   Weir TR; Temporal response analysis software for time-

based metrology such as thermal sensor wafers. 

Weir Matching Match and feature or overlay data to the time-based data of 

Weir TR 

Weir Layout Graphic exposure layout and data centering tool. 
 

VectorRaptorOV.zip Product Description 



Getting Started with TEA Products   

Product Upgrade  - Page 3  - 

“Zip” File TEA Product 

Vector Raptor Advanced Overlay and Registration control with special tools 

for Double Patterning and Double Exposure 

VR Matching Match multiple feature, film and overlay data sets. 

Weir Layout Graphic exposure layout and data centering tool. 
 

From a TEA Product CD-rom 

Weir and Vector Raptor software CD-roms are in html format. 

You can access the products, manuals and tutorials using the interface controls that appear on the 

main screen. 

Place the CD-rom into your computer. It should startup automatically. If it does not, then click on 

the “Index.htm” file.  

You will need to obtain a demo license to use the software regularly. Without the license you can 

start the software up to 10 times before it will lock up. The license is keyed to the installation date 

and your computer. See the attached memo for license management and installation.  

Obtaining a license is easy.  When the software is first started Weir will display a License  

Email Addresses: 

WeirEngr@TEAsystems.com 

Sales@TEAsystems.com 

PPrroodduucctt  UUppggrraaddee  

Product Updates and Upgrades can be downloaded directly from the TEA Systems internet site. 

Go to the TEA User’s Area at: 

http://www.teasystems.com/UserArea/index.html 

Select the “Upgrades” command button. 

 

Each upgrade includes a compressed self-extracting ".exe" file that can be directly installed under 

Window 2000, Windows Server 2003 or Windows XP. This file will self install after 

downloading.  

 Instructions: 

1. Download the file into a temporary directory on the Weir or LithoWorks computer . 

2. Installation: 

o The download is a self-extracting executable file (i.e. files ending in ".exe").  

o Simply double-click on the file to begin installation or  

o Extract the contents of the zip file into a temporary directory.  

o Run the "Setup.exe" program 
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PPrroodduucctt  RReemmoovvaall  

To remove TEA System’s Products 

1) FIRST remove the product license if you wish to re-install the software on another computer. 

a) Detailed steps for license removal are in the next section. 

b) Sent the License to Sales@TEAsystems for credit. 

2) Remove the Product from your Windows computer 

a) Select the menu Start/Settings/Control Panel 

b) Select the icon “Add/Remove Programs” 

c) Select the Install/Uninstall tab. 

d) Scroll down to the product name. 

e) Follow the on-screen instructions. All portions of the software will be removed. 

LLiicceennssee  IInnssttaallllaattiioonn  

TEA Systems products are license protected by an encrypted code that is tied to the unique 

hardware configuration of the installation computer.  

TEA Systems can give you a new license by email that will allow you to use the software for a 

fixed time frame or as a permanent license. 

If a product must be moved to another computer, then the license from the current computer 

should be removed prior to removal of the actual product. When you remove the license, using the 

License Manager, a License Removal Code will be given to you. Having this License Removal 

Code you can then send it to TEA Systems for credit for it’s re-installation on the new computer. 

License Manager Startup 

The first time you start up the program, the TEA Systems License Manager, shown above in 

Figure GS1 will appear. 

After the initial installation, you can access the license manger from the “Tools/License Manager” 

menu of each product interface. 

Initial Product Startup 

See the Previous section for program installation instructions. 

Program startup and license installation consists of the following steps: 

1. Install the program 

2. Run the program for the first time  

3. The TEA Systems License manager will appear and request you to: 

a. Enter a license ID or 

b. Continue without entering a new License ID. 
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i. You can start the software ten (10) times without a license. 

To get a TEA Product License: 

1) Record the values shown in the License Manager for variables “ID A” and “ID B” . 

2) E-mail “ID A” and “ID B” to TEA Systems at: Sales@TEAsystems.com 

a) OR the software may offer to email these values for you to TEA Systems. You will be 

able to review the email prior to transmission. 

b) OR us the “Email Request” command button shown on the License Manager shown in 

Figure GS1. 

3) TEA Systems will return a Product License to you by E-mail. 

a) Your returned Product License will be in the form of a Hexadecimal number (Manual 

Update) and an attached ASCII File (Automatic Update). You may use either form to 

update your license 

4) Manual Update: Enter the license value in the License Manager to continue running the 

software without interruption then press the “Enter Confirmation” command button OR 

5) Automatic Update: Download the “License.dat” file into your Weir Program directory for 

automated installation. 

• Weir Program Directory Location: The path to your program directory can be found in 

the menu at “Help/About”. Use “Ctrl C”/ “Ctrl-V” to copy and paste it into the license 

manager.  

Type of Product Licenses 

TEA Systems Products offer two types of product licenses. 

1. Fixed-Node License 

a. The product is installed on a single computer and must be used on this 

computer. 

 

Figure GS1: TEA Systems Product License Manager Interface 
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b. Only one user at a time may use the software. 

2. Floating-Node License 

a. The product is installed on a single computer. 

b. The license is keyed to the installation computer. 

c. The product may be used on any network node that can access the installation 

computer. 

d. Only one user at a time may use the software. 

e. The software instance will terminate if left inactive for ½ hour to allow it to be 

used by others on the network. 

Product License Removal 

Since the product license is keyed to the hardware of your computer, moving a TEA Product to 

another computer requires you to first remove the installed product license to obtain a Product 

Removal Key. You can remove the software by pressing the “Remove” button located on the left 

side of the License Manager interface as shown on Figure GS1. 

Next install the TEA Product onto your new computer. 

Email the Product Removal Key to Sales@TEAsystems.com along with the “ID A” values of your 

new installation to obtain a  

IInniittiiaall  DDaattaa  LLooaaddiinngg  

Weir Data is ALWAYS loaded from it’s storage in an Excel Workbook. Data is structured in the 

Workbook using the Weir Standard Format. The Weir Standard format is a public format and is 

defined in the file attached to the following link: 

Weir Standard Format.pdf 

Which can be found on our website at: 

http://www.teasystems.com/General/ProductOverviews.htm 

Weir Standard Data Format 

Data is typically imported from a metrology tool’s binary or ASCII format data file. The data 

formats are then converted into the Weir Standard Format and stored into Spreadsheets. After a 

data set has been imported into a spreadsheet, the spreadsheet should then be opened and re-used 

for future work since there is no need to re-import the raw data. 

Weir Workbooks store data, analysis reports, summaries and additional data created from some of 

the analyses. The worksheets can be located using the “Index” worksheet and it’s hyperlinks. 

There’s a minimum of three worksheets stored in each  workbook: 

o DataSheet  The primary, imported data as measured. The sheet-name is the 

same as the data set name. 

o “Sites” A sheet of field locations and feature family information. 

o “Information” Header information containing diesize, flat location etc. 

Formats and conventions for these are discussed below 
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Data Accessible to the Weir Suite  

TEA Systems Products are engineer’s tools with production script automation for wavefront 

engineering and semiconductor process control.  Overlay, registration, critical dimension, all 

ellipsometer, scatterometer and film thickness data can be imported from many source formats 

including:  

Accent Optical CDS 200 family KLA ProData files (*.pfe) 

Applied Materials (AMAT) NanoSEM 3D  NanoMetrics OCD Scatterometer family 

ASML self registration files including FOCAL Nikon NRM Series Overlay (*.msr) 

BioRad Questar (several formats) Nova Track 2020-3030 Overlay (*.csv & 

*.xls) 

Hitachi Laxxx Overlay OnWafer Thermal probe (*.csv) files 

IVS Overlay Family (IVS 130 etc. from Schlumberger) SensArray Thermal probe files (*.csv or 

*.xls stored data) 

IVS CD-SEM family (IVS 230 etc. from Schlumberger) Schlumberger Yosemite CD-SEM (*.tab, 

*.csv and space delimited) 

KLA Archer overlay family Therma-Wave RTCD Ellipsometer 

KLA ASET F5 Ellipsometer SCD Timbre Technologies ODP scatter analysis 

(*.csv and space delimited.) 

KLA 5xxx Overlay family Excel-based Focus-Dose data in table format 

KLA 8xxx CD-SEM family and others … 

Weir Engineering is always striving to expand the range of data imports and welcomes sample 

files from any source. Remember, there is never a charge to update or expand the list of imported 

data sources. If your metrology tool is not on this list then please submit a data sample for 

analysis. 
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Importing Data 

Metrology data can be easily imported. Data is imported and reformatted into a Weir Workbook. 

The Weir Workbook for the data, using the same name as the source file, is automatically and 

immediately loaded into the TEA Product Application. You can begin analysis without additional 

steps. 

You can set the data import behavior options using the “Tools/Options” menu to define where data 

is stored and it’s behavior. For example, you can specify: 

o Set a fixed data-source location or allow it to float to the last-location used. 

o Set a default data import filter type 

o Set the storage location of the Weir Data Workbook created from the metrology file. 

After a data set is imported the first time then use it’s Weir Workbook to load the data into future 

product analysis sessions. You do not have to use the data import to reload data sets. 

TEA Products allow data to be imported using: 

o The “File/Open Data” menu to access the interface shown in Figure Data1. 

o Drag and drop data files into the active TEA Product screen. 

o User the Weir DMA command line arguments in calls from other products. 

The type of metrology data being loaded must be first set by using the “File/Open Data” menu. 

This interface remembers the directory and type of data import until you change it. After the first 

file is loaded, you can then use the drag-drop technique from any directory on the network. To 

open the data file: 

o Start the TEA Product and select the “File/Open Data” menu. 

o Select the data type using the “Files of type” drop-down control. 

o Select the data file and then press the “Open” command button. 

 “File/Open” or “file open” button. Imported data is automatically converted into the Weir 

Standard Format and stored into a Workbook as shown in the figure. The workbook will be the 

 

Figure Data1: Data import and conversion. 
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same name as the raw data file and in the same directory. Workbooks can then be renamed and 

moved to other locations, if desired. 

Loading Weir Data Workbooks 

Use the “File/Open Workbook” or “Open Workbook” button on the button-bar to load Weir 

Standard formatted data directly into the application. You can also drag-and-drop any Data 

Workbook or by using program calls from the Weir DMA interface. 

Loading Auxiliary Data Worksheets 

Data Worksheets are created as the result of an analysis performed. These worksheets include: 

o Best Focus Uniformity 

o Dose Uniformity Analysis 

o Feature Focus Uniformity Analysis 

o Etc. 

To load a worksheet, first load the parent data workbook. The worksheets that contain data are 

listed in a drop-down control located in the upper right side of the interface. Simply select a 

datasheet from this dropdown to reload the auxiliary data sheet. 

DDeeffiinniinngg  aann  EExxppoossuurree  LLaayyoouutt  aanndd  DDaattaa  CCeenntteerriinngg  

Weir Layout provides access to: Exposure Layout, Wafer & Field Centering, Die-Size, Wafer 

Size, Wafer & Field offsets, Lot overhead information. 

Weir Layout is a graphic interface used to define the organization of exposure, overhead and 

cantering layouts in the lot. Exposure layouts can be defined for a single wafer or across multiple 

wafers in the lot. 

Layouts can be saved as Weir Layout Templates using the “File” menu command of the same 

name. New data sets without exposure layout information AND  Weir DM datasets can then be 

updated by selecting the appropriate Weir Layout Template from the “File” menu sub-command 

of any TEA Product Interface. 

Exposure Layouts include the Field-by-Field specific location of each exposure as referenced to its 

position in the lot. Exposure variables setup can include the Focus, Dose, Numeric Aperture (NA), 

Inner Partial Coherence (PCinner or Inner Sigma), Outer Partial Coherence (PCouter or Outer 

Sigma) and reticle stage travel direction. While any alphanumeric value can be inserted for these 

values, the focus and dose values are critical if a focus/dose process window, dose uniformity or 

focus uniformity calibration is to be performed. 

The exposure values of each field can be directly entered onto the field-graphic and then saved 

using the “Save” command button. Automated entry tools for standard layout configurations 

including the serpentine layout are located to the left of the wafer-graphic. 

Layout information is stored in the Weir Workbook associated with the data under the “Layout” 

worksheet. 

Starting Weir Layout 

The Weir Layout interface can be started directly from the Windows Start Menu. You can also 

access it from any TEA Product “Layout, Array Centering” submenu of either the Analysis or 

Tools menu. 



Getting Started with TEA Products   

- Page 10 - Defining an Exposure Layout and Data Centering 

Setting up a Serpentine Focus Variation 

In this section we will go through a step-by-step account, illustrating how the exposure values of a 

focus-dose matrix array can be specified using the automated layout controls of the Weir Main 

screen. For this example, we want to specify a serpentine variation in focus across the wafer 

starting at 0.6 microns defocus in the lower left and stepping from right-to-left in 0.1 um 

increments. Follow the text boxes illustrated in Figure WL1 

Note: Values will be added to ALL wafers of the data set unless you first manually 
select an individual wafer from the “Wafer” drop-down control. 

Use the File/Open menu to select and import the data. 

1) Select the “Layout” tab. 

2) Press “Draw” to display the previously-centered array. 

3) Change the “format” to “Serpentine” 

4) Change “fo” (initial focus) to 0.6 and and “Step” to –0.1 

5) Double-click on the outer die, selecting it as the origin. 

6) Select the relative location and travel direction of the array you will be filling. In this case, 

click the origin button located as shown. For this location, fields to the left and then upward of 

the origin die (step 5) will be filled in. 

7) Click on “Update” to fill in the array values. Then click “Save” to save the data to the 

“Layout” spreadsheet. 

 

Figure WL2: Specifying constant Partial Coherence in the layout. 
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Adding a Constant Partial Coherence Value to the Array 

Now that we have set up the focus, we desire to specify a constant Sigma or Partial Coherence 

(PC) for all die in the data set. Note that if PC varies from wafer to wafer, you need to first select 

the appropriate wafer ID from the dropdown list. Refer to Figure WL2 for this exercise. 

1) Select the “PC_outer” variable 

� Note PC inner is used to define “ring” and other apertures. 

2) Change the “format” to “Constant” 

3) Change “PC” (initial sigma) to 0.63.  

� “Step” will automatically change to 0 because of the “Constant” setting. 

� With Constant settings, it is not necessary to set an origin die. 

4) Click on “Update” to fill in the array values. Then click “Save” to save the data to the 

“Layout” spreadsheet. 

5) Check that the Dose, NA etc values are correct. You can reset these values in the same 

manner as this by changing the “Variable” field. This field will add additional rows as 

additional-unique values are added to the array. 

GGrraapphhiiccss  

Modifying Graphics 

Graph colors, line-weight, display range, scale, format, titles and fonts can be interactively 

modified by clicking on the graphic using the right mouse-button. 

Trend and XY plots can access all of the above plus the user can also add and modify: 

• on-plot messages 

• plot-symbols, 

• line and axes weight, color 

• box-plots, population color-coding and population contour lines 

• Trend-lines fitted to any existing data curve of the graph with up to a 4
th

 order polynomial. 
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Getting There 

“Right Click” on the graphic using the right button of the mouse the interface shown in Figure  

will appear. Use the command tools in this interface to modify the graphic. More details are 

located in the product manual. 

This interface is available from any graphic. Select the tabs to modify the screen background, titles 

or curve symbols. Clicking the “Apply” command button will submit the changes to the current 

graph without exiting the screen. 

Mouse Generated Graphics 

When the mouse is moved over an XY graph, the value of the data and location on the graph is 

shown in a pop-up bulletin. 

Use the left-mouse button to box in a section of data. When the box is drawn, a pop-up menu will 

appear that will allow you to: 

o Rescale an XY graphic by extending the box over one or two axes of the graph. 

o Cull data points located within the box. 

o Cull full-wafers of data. 

o Restored culled data points 

o Examine the boxed-in data points by displaying them in a spreadsheet pop-up. 

o Create a histogram or XY plot of the selected data. 

DDaattaa  CCuulllliinngg  

Data Culling can occur on many levels. Data points are never actually deleted but can always be 

easily restored. 

o The first interface in most TEA Products allows the user to select sub-sets of data using the 

drop-down controls. These controls allow the analysis to be restricted to: 

 

Figure Graphic1: Graph Options customization screen 
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� Selected wafers of the lot. 

� Selected “Families” of data as defined on the “Sites” worksheet. 

� Selected values of the Scan Direction, Numeric Aperture, Sigma/Ring Aperture, 

Focus, Dose. 

� Delete a specific field site or group of sites on the field by boxing in the field site on 

the Site Layout graphic with the mouse. 

� Delete specific data measurements by boxing in data points on the wafer graphic. 

� Restrict data to a range of values using any data variable. This control also contains a 

simple histogram generator to assist in determining the realistic variable range. 

� On the “Spatial” mapping sections of the products, restrict data to data points located 

within a specified radius of the wafer center. This control also contains a set of 

graphics to show the radial distribution of variables on the wafer. 

� Restrict data that is included in the analysis using a given Range and/or Sigma 

distribution value to limit the maximum variation of the data from the population 

median. A set of “Range” and “Sigma” data distribution plots can be generated using 

the Range Command button. 

�  

HHaarrddwwaarree  aanndd  SSooffttwwaarree  RReeqquuiirreemmeennttss  

o Requires Microsoft Windows 2000 or Window XP. Microsoft Excel® is also required for 

storage of data.  Minimum recommended Hardware: 

o Display with 1024 x 768 pixels resolution 

o Pentium III, 1 GHz or greater 

o 128 Meg. RAM or more 

o 50 Meg. In program directory 

o 2 Gigbyte Data directory 

o Microsoft Excel from Office 2000 or later 

o VBA, Macro interface add-in must be installed for remote control by Weir 

o Windows 2000, Windows Server 2003,  XP Professional 

 


